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Creating a Table 
 
Tables are very useful tools in creating and formatting 

documents. For example, with a table you can: 
 

Align Text, Numbers, and Graphics: Tables make 

it easy to align text, numbers, and graphics in 

columns and rows. Many users prefer using tables to 

align text instead of tab stops, because text can wrap 

to multiple lines in a table. 
 

Create a Form: You can use tables to store lists of 

telephone numbers, clients, and employee rosters. 
 

Share Information: You can use tables to share 

information between programs. For example, you can 

copy and paste a table’s information into a Microsoft 

Excel worksheet or Access database. 
 

Create a Publication: Tables make it easier to 

create calendars, brochures, business cards, and 

many other publications. 
 

Insert a table 
 
To create a table, you must first specify how many 

columns (which run up and down) and rows (which run 

left to right) you want to appear in your table. Cells are 

small, rectangular- shaped boxes where the rows and 

columns intersect. The number of columns and rows 

determines the number of cells in a table. 
 
If you don’t know how many columns and rows you want 

in your table, take an educated guess—you can always 

add or delete columns and rows later. 
 

 Click the Insert tab on the Ribbon and click the 

Table button in the Tables group. 
 

A grid appears, representing rows and columns in 

the table. As you move the cursor inside the grid, the 

number of rows and columns that will appear in the 

table is updated at the top of the list. A preview of 

how the table will look in the document also appears 

as you drag your cursor across the grid. 
 

 Select the number of columns and rows you want 

to create using the new table grid. 
 

The table is inserted with the number of columns 

and rows you selected. 
 

Other Ways to Insert a Table:  
Click the Insert tab on the Ribbon and click 

the Table button in the Tables group. Select 

Insert Table from the list and select the 

number of columns and rows you want to use 

in the Insert Table dialog box. Click OK. 

 

 
 Exercise  

 Exercise File: None required. 
 

 Exercise: Open a new Word document and insert a 

table that is three columns wide by four rows tall.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9-1: Inserting a table.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9-2: The Insert Table dialog box.  
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Working with a Table 
 
In order to work with a table, you need to learn a few 

basic skills: how to move the insertion point between 

cells, how to enter or edit table data, and how to select 

items. 
 

Move between cells 
 
There are several ways to move between cells in a table: 
 
Click in a cell with the mouse. 
 
Use the up, down, left, and right arrow keys. 
 

Press <Tab> to move forward one field or cell, 

and press <Shift> + <Tab> to move back one 

field or cell. 
 

Enter or edit information in a table 
 

 Click a cell in the table. 
 

The insertion point appears in the cell. 
 

 Enter or edit text or numerical data as desired. 
 

If you enter more text than fits in a cell, the cell 

height expands automatically to hold it. 
 

Select cells, rows, columns, and tables 
 
Just like other elements in Word, you have to select 

the parts of a table in order to work with them. 
 

 Position the insertion point in the cell, row or column 

you want to select. 
 

 Under Table Tools on the Ribbon, click the Layout 

tab and click the Select button in the Table group. 

 
 Choose the table item you want to select: 

Cell, Column, Row or Table. 
 

 Other Ways to Select: 
 

Cells: Click the left edge of the cell. 
 

Multiple Cells: Drag across the cell, row, or 

column. Or select a single cell, row, or column 

and hold down the <Shift> key while you 

click another cell, row, or column. 
 

Row: Click to the left of the row (outside of 

the table). 
 

Column: Click the column's top border 

(the pointer will change). 
 

Table: Click the move handle next to the 

table (must be in Print Layout view). 

 

 
 Exercise  

 Exercise File: SalesReps9-2.docx 
 

 Exercise: Practice moving the cursor around within the 

table cells. 
 

Enter the following text in the three cells of the first row: 

Last, First, Sales. In the second row, enter: Jones, Marvin, 

1200. In the third row, enter: McKenzie, Shandra, 1400. 

Select the third row.  
 
 
 
 
 
 
 
 
 
 

 
Figure 9-3: The Table group.  
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9-4: A table with the first row selected. 
 
 
 
Move handle  
 
 
 
 
 
 

 
Figure 9-5: A table that is entirely selected.  
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Resizing and Moving a Table 
 
You can quickly and easily resize or move a table 

in Word. 
 

Resize a table 
 
You can use the mouse to resize a table. 

 

 Make sure you are in Print Layout view. 
 

 Click anywhere inside the table, if necessary. 
 

The table’s resize handle appears in the lower right-

hand corner of the table until the table is the desired 

size. 
 

As you resize the table, a dotted outline appears to 

show you the new outline of the table. 
 

Move a table 
 
Moving a table is very similar to resizing it. 

 

 Make sure you are in Print Layout view. 

 
 Click anywhere inside the table, if necessary. 

 
The table’s move handle appears in the upper 

left-hand corner of the table. 
 

 Click and drag the table’s move handle to a 

new location on the page. 
 

As you move the table, a dotted outline appears to 

show you the new location of the table. 

 

 
 Exercise  

 Exercise File: SalesReps9-3.docx 
 

 Exercise: Resize the table so that it is about five inches 

wide by one inch tall (use Word’s rulers as a guide). 

Move the table down about one inch. 
 
 
 
 
 
 
 
 
 
 
 

 
Resize  
handle 

 
Figure 9-6: Resizing a table. 

 
Move handle  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9-7: Moving a table.  
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Adjusting Table Alignment 

and Text Wrapping 
 
In the Table Properties dialog box, you can adjust the 

alignment of a table within the document, as well as the 

way document text wraps around a table. 
 

 Select the table. 

 
 Under Table Tools on the Ribbon, click the 

Layout tab and click the Properties button in the 

Table group. 
 

The Table Properties dialog box appears. 
 

Tip: Click the Options, Positioning, or Borders 

and Shading buttons for even more detailed 

table options.  
 

 Select the Table tab if it isn’t already selected. 
 

Here you can adjust table alignment within the 

document—select from Left, Center, or Right 

alignment—as well as whether or not you want the 

document text to wrap around the table. 
 

 Select an Alignment or Text wrapping option 

and click OK. 
 

The table alignment or text wrapping is adjusted. 
 

Trap: If your table is as wide as the page, or if 

you don’t have any text in the surrounding 

document, you won’t notice any difference 

between the alignment or text wrapping 

options, respectively.   
Tip: The Table Properties dialog box also 

includes tabs for Row, Column, and Cell 

properties. Here you can adjust row and column 

size, as well as individual cell size and alignment 

of cell contents.  

 

 
 Exercise  

 Exercise File: SalesReps9-4.docx 
 

 Exercise: Align the table in the center of the page.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 9-8: The Table Properties dialog box.  
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Working with Cell Formatting 
 
In this lesson, you will learn how to align text 

horizontally and vertically in a cell, change text 

direction, and adjust cell margins. 
 

Align cell contents 
 

 Select the cell(s) containing information you want to 

align. 
 

The Design and Layout tabs appear under the 

Table Tools on the Ribbon. 
 

 Under Table Tools on the Ribbon, click the 

Layout tab and click an alignment button in the 

Alignment group. 
 

Other Ways to Align Cells:  
Select the cell(s), right-click, select Cell 

Alignment from the contextual menu, and 

select an alignment. 
 

Change text direction 
 

 Select the cell(s). 
 

The Design and Layout tabs appear under the 

Table Tools on the Ribbon. 
 

 Under Table Tools on the Ribbon, click the 

Layout tab and click the Text Direction button in 

the Alignment group. 
 

The text direction for the selected cell(s) changes. 

 
 Click the Text Direction button again to 

cycle through available directions. 
 

Other Ways to Change Text Direction: Select 

the cell(s), right-click, and select Text Direction 

from the contextual menu. Select an orientation 

from the Text Direction dialog box.  
 

Adjust cell margins 
 
You can adjust how much space appears between a 

cell’s contents and its borders by adjusting cell margins. 
 

 Click anywhere inside the table. 
 

The Design and Layout tabs appear under the 

Table Tools on the Ribbon. 
 

 Under Table Tools on the Ribbon, click the 

Layout tab and click the Cell Margins button in 

the Alignment group. 
 

The Table Options dialog box appears. 

 

 
 Exercise  

 Exercise File: SalesReps9-5.docx 
 

 Exercise: Select the first row and change the text 

direction. Then undo the action. 
 

Apply Bottom Center alignment to the first row of the table. 
 

Change the top default cell margin to 0.05” and allow 

spacing between cells of 0.03”. 

 
 

 
Alignment 
buttons  

 
 
 
 
 
 
 

 

Figure 9-9: The Alignment group.  
 
 
 
 
 
 
 
 
 

 

Figure 9-10: Changing text direction.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 9-11: Changing table cell margins using the 

Table Options dialog box.  
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 Adjust the cell margins and click OK. 
 

Not only can you change the distance from the cell 

contents to the cell borders, but you can also 

separate individual cells from other cells in the table 

by adjusting the Default cell spacing area of the 

dialog box. 
 

Tip: Adjusting cell margins changes the margins  
of the current table and all subsequent tables. Your  
changes become the default settings for all tables.  
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Merging and Splitting 

Cells and Tables 
 
You can adjust the number of cells that appear in a 

table by merging and splitting cells. You can also split 

a table into two tables. 
 

Merge cells 
 
The merge cells command combines several smaller 

cells into a single larger cell that spans the space that the 

previous cells occupied. 
 

 Select the cells you want to merge. 

 
 Under Table Tools on the Ribbon, click the 

Layout tab and click the Merge Cells button in 

the Merge group. 
 

Other Ways to Merge Cells:  
Select the cells you want to merge, then right-

click and select Merge Cells from the 

contextual menu. 
 

Split a cell 
 
Cells can also be broken up into several smaller cells 

by using the Split Cells command. 
 

 Select the cell you want to split. 

 
 Under Table Tools on the Ribbon, click the 

Layout tab and click the Split Cells button in the 

Merge group. 
 

Other Ways to Split a Cell:  
Select the cell you want to split, then right-click 

and select Split Cells from the contextual menu. 

 
 Specify how you want to split the cell in the Split 

Cells dialog box and click OK. 
 

Split a table 
 
You can also split a table into two separate tables. 

 

 Select the table row where you want to split the table. 
 

The row you select will become the first row of the 

new table. 

 

 
 Exercise  

 Exercise File: SalesReps9-6.docx 
 

 Exercise: Split the first cell in the fourth row of the table 

into two cells, then merge the two cells back together. 
 

Split the table so that the Shandra McKenzie row is the first 

row of the new table. 
 

Undo the split.  
 
 
 
 
 
 
 
 
 
 
 
Figure 9-12: The Merge group.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9-13: The Split Cells dialog box.  
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 Under Table Tools on the Ribbon, click the 

Layout tab and click the Split Table button in the 

Merge group. 
 

The table is split into two tables. If the new table 

overlaps or obstructs the original table, you may need 

to move the tables in order to view them. 

 

 
Before  
 
 
 
 
 
 
 

 
After  

 
 
 
 
 
 
 
 

 
Figure 9-14: Before and after splitting a table.  
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Inserting and Deleting 

Rows and Columns 
 
In this lesson, you will learn how to delete entire columns 

and rows and how to insert new columns and rows. 

You’ll also learn how you can repeat the header row on 

tables that span multiple pages. 
 

Insert a row 
 

 Place your insertion point in the row that is above or 

below where you want to insert the new row. 
 

 Under Table Tools on the Ribbon, click the 

Layout tab and click the Insert Above or Insert 

Below button in the Rows & Columns group. 
 

Other Ways to Insert a Row:  
Place the insertion point in the bottom-right cell of 

the table and press <Tab> to insert a new row at 

the bottom of the table. Or, right-click a row, point 

to Insert, and select Insert Rows Above or Insert 

Rows Below from the contextual menu. 

 

Insert a column 
 

 Place your insertion point in the table in the 

column that is left or right of where you want to 

insert the new column. 
 

 Under Table Tools on the Ribbon, click the Layout 

tab and click the Insert Left button or the Insert 

Right button in the Rows & Columns group. 
 

Other Ways to Insert a Column:  
Right-click and point to Insert and select Insert 

Columns to the Left or Insert Columns to the 

Right from the contextual menu. 

 

Delete a row or column 
 

 Select the column(s) or row(s) you want to delete. 

 
 Under Table Tools on the Ribbon, click the 

Layout tab and click the Delete button in the 

Rows & Columns group. 
 

 Select Delete Rows or Delete Columns from the list. 
 

Other Ways to Delete Rows or Columns: 

Select the row(s) or column(s), right-click, and 

select Delete Rows or Delete Columns from 

the contextual menu.   
Tip: You can also delete individual cells in a 

table. Select the cell(s) you want to delete and 
 

 

 
 Exercise  

 Exercise File: SalesReps9-7.docx 
 

 Exercise: Insert a row between the first and second 

rows, then delete the row.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 9-15: The Rows & Columns group.  

 

 



First level / Microsoft Word 2010  Lab 9: Working with Tables 

 

Mustansiriyah University/ College of Dentistry  Lecturer: Mustafa H. Ali 

 

P
a

g
e
1

0
 

 
 

 
click the Delete button in the Rows & Columns 

group. Select Delete Cells and click OK. 

 

Repeat header rows 
 
If you have a table that extends across several pages, you 

can repeat the header row at the top of each page of the 

table. 
 

 Select the rows you want to use as headings. 

 
 Click the Layout tab under Table Tools on 

the Ribbon. 
 

 Click the Repeat Header Rows button in the 

Data group. 
 

Tip: You can also keep a table row from breaking 

and separating the row’s contents onto two pages. 

Right-click the table and select Table Properties 

from the contextual menu. On the Row tab of the 

Table Properties dialog box, deselect the Allow row 

to break across pages option.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 9-16: The Data group.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



First level / Microsoft Word 2010  Lab 9: Working with Tables 

 

Mustansiriyah University/ College of Dentistry  Lecturer: Mustafa H. Ali 

 

P
a

g
e
1

1
 

 
 

 

Adjusting Row Height 

and Column Width 
 
When you create a table, all of the rows and columns 

are the same size. As you enter information in a table, 

you will quickly discover that some of the rows and 

columns are not large enough to properly display the 

information they contain. 
 

Adjust row height 
 
You will seldom need to change a row’s height because, 

unless you specify otherwise, rows automatically expand 

to the tallest cell in the row—the one that contains the 

most lines of text. 
 

 Select the row(s). 

 
 Under Table Tools on the Ribbon, click the 

Layout tab. 
 

 Click the Table Row Height text box in the Cell 

Size group and specify the row height. 
 

Other Ways to Adjust Row Height:  
In Print Layout view, click and drag the 

row’s bottom border up or down. 
 

Tip: You can distribute selected rows evenly so 

they are the same height. Select the rows, click 

the Layout tab under Table Tools, and click the 

Distribute Rows button in the Cell Size group.  
 

Adjust column width 
 

 Select the column(s). 

 
 Under Table Tools on the Ribbon, click the 

Layout tab. 
 

 Click the Table Column Width text box in the 

Cell Size group and specify the column width. 
 

Other Ways to Adjust Column Width:  
In Print Layout view, click and drag the column’s 

right border to the left or right. Or, double-click 

the column’s right border. Or, click the AutoFit 

button and select an option to automatically 

resize the columns to fit their contents or the size 

of the window. 
 

Tip: You can distribute columns evenly so that 

they are the same width. Select the columns, click 

the Layout tab under Table Tools, and click the 

Distribute Columns button in the Cell Size 

group.  

 

 
 Exercise  

 Exercise File: SalesReps9-8.docx 
 

 Exercise: Adjust the third column’s width to 1”. 

 
 

 
Table Column Width  

 
 
 
 
 
 
 
 
 

Table Row Height 

 
Figure 9-17: The Cell Size group.  
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Using Table Drawing Tools 
 
In Word, you can draw and modify tables the same 

way you would use a pencil to draw a table on a piece 

of paper. You may find the table drawing tools to be 

especially helpful when creating or modifying 

complicated or irregular tables. 
 

Draw borders 
 

 Under Table Tools on the Ribbon, click the 

Design tab and click the Draw Table button in the 

Draw Borders group. 
 

The pointer changes to look like a pencil. 

 
 Click and drag to draw boundaries, rows, columns, or 

table cells. 
 

Tip: Use the Line Style, Line Weight, and Pen 

Color commands in the Draw Borders group 

to determine how the borders appear.  
 

Erase borders 
 

 Under Table Tools on the Ribbon, click the Design 

tab and click the Eraser button in the Draw 

Borders group. 
 

The pointer changes to look like an eraser. 

 
 Click and drag across table lines to erase the lines. 

The border is erased. 

 

 
 Exercise  

 Exercise File: SalesReps9-9.docx 
 

 Exercise: Add a vertical line to the last cell of the first 

column so that the cell is split in half, then erase that line. 
 

Erase the vertical line in the fourth row that separates the 

first and second columns.  
 
 
 
 
 
 
 
 
 
 
 
 
Figure 9-18: The Draw Borders group.  
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9-19: Erasing a table border.  
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Working with Sorting and 

Formulas 
 
Word provides many options for working with table data. 

You can sort table data into a more useful order and even 

perform calculations by inserting formulas into table cells. 
 

Sort table data 
 
Word can sort data in a list alphabetically, numerically, 

or chronologically (by date). In addition, Word can sort 

information in ascending (A to Z) or descending (Z to A) 

order. You can sort an entire table or a portion of a table 

by selecting what you want to sort. 
 

 Select the cells or information you want to sort. 
 

Usually, you’ll want to select the header row 

along with the rows you want to sort. 
 

 Under Table Tools on the Ribbon, click the 

Layout tab, and click the Sort button in the Data 

group. The Sort dialog box appears. 
 

 Define how you want to sort the data and click OK. 

 

Use formulas in a table 
 
Word is not a spreadsheet program like Microsoft Excel, 

which is made to perform calculations, but it can do 

some simple arithmetic. 
 
To enter your own calculations, called formulas in 

Word, you can use the Formula dialog box, and you can 

refer to the cells in a table using cell references. A cell 

reference identifies where a cell is located in a table. 
 
Although tables don’t have visible headers identifying the 

rows and columns, every cell reference uses a letter (A, B, 

C and so on) to represent its column and a number (1, 2, 3 

and so on) to represent its row. A1, B3, and D5 are all 

examples of cell references. 
 

 Place the insertion point in a blank table cell where 

you want to insert the formula. 
 

 Under Table Tools on the Ribbon, click the Layout 

tab and click the Formula button in the Data 

group. The Formula dialog box appears. 
 

 Enter the formula in the Formula box. 
 

For example, =SUM(C2, C3) calculates the sum 

of table cells C2 and C3. 

 

 
 Exercise  

 Exercise File: SalesReps9-10.docx 
 

 Exercise: Select the first three rows and sort by the Sales 

column in descending order so that the salesperson with the 

most sales is listed first. 
 

Enter a SUM formula in the last cell of the third column to 

calculate the total sales.  
 
 
 
 
 
 
 

 

Figure 9-20: The Data group.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 9-21: The Sort dialog box. 

 
Before  
 
 
 
 
 
 
 
 

 
 Column sorted in 

Cell A1 descending order 
  

After 

 
 
 
 

 
Sum formula  

 

Figure 9-22: A table before and after sorting the table 

data and adding a formula to sum the third column. 
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Use the Number format list arrow to define how the 

formula result appears. Use the Paste function list 

arrow to build a formula using built-in functions. 

 
 Click OK. 

 
The formula result appears in the cell. 

 

Tips 
 
 Remember: All formulas start with an equal sign (=), 

followed by a function name (such as SUM), 

followed by parentheses containing the location of 

the cells on which you want to perform the 

calculation.


 Besides regular cell references, you can use terms 

that describe the location of cells in a table, such as 

Above or Left, which reference all cells above or to 

the left, respectively, of the selected cell. For 

example, =SUM(ABOVE) totals all the cells above 

the selected cell in a table.


 If you change a value in a Word table, you’ll need 

to recalculate the formulas manually.

 
 
 
 
 
 
 

 
Instead of entering specific cell references you want to sum, you 

can use a reference such as ABOVE, which indicates all the 

cells above the cell containing the formula.  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 9-23: The Formula dialog box.  
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Working with Borders 

and Shading 
 
Borders improve a table’s appearance, giving it a 

polished, professional look. Borders can make it easier 

to read the information in a table, especially when the 

information is numerical. 
 
Adding shading to a table is similar to adding borders— 

you select the cells and then select shading options. 
 

Apply a table border 
 
When you create a table, Word automatically adds 

borders or lines around every cell in the table, but it’s 

very easy to change, add, or remove your table’s borders. 
 

 Select the cells where you want to adjust the borders. 

The Table Tools appear on the Ribbon. 
 

Tip: To select the whole table, click the 

table’s move handle. 
 
 

 Under Table Tools on the Ribbon, click the 

Design tab, and click the Borders list arrow. 
 

Here you can choose from several border options. 
 

Tip: Select No Border to remove a border 

from the selection. 
 
 

 Select the border type you want to apply to the 

selected cells. 
 

The border is applied. 
 

Other Ways to Apply a Table Border:  
Select the cells where you want to apply a 

border. Under Table Tools on the Ribbon, click 

the Design tab and click the Borders list arrow. 

Select Borders and Shading from the list. Or, 

right-click the selection and select Borders and 

Shading from the contextual menu. Use the 

commands on the Borders tab in the Borders and 

Shading dialog box. 
 

View gridlines 
 
Gridlines are dashed lines that show you the location of 

the table cell borders. They do not appear by default. 
 
You can easily display and hide table gridlines, but the 

gridlines won’t be visible if the table is in the default table 

format because the black border covers the gridlines. 

 

 
 Exercise  

 Exercise File: SalesReps9-11.docx 
 

 Exercise: Select the entire table and apply No 

Border. Display gridlines. 

Select only the first row and apply a Light Blue fill color (in 

the Standard colors area). 
 

Select the entire table again and apply All Borders.  
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9-24: A table with no border and 

gridlines displayed. 
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 Select a table. 

 
 Under Table Tools on the Ribbon, click the Layout 

tab and click the View Gridlines button in the 

Table group. 
 

Gridlines are displayed in all tables in the document. 
 

 Tip: Gridlines do not print. 
 

Now let’s hide the gridlines. 

 

 Click the View Gridlines button 

again. Gridlines are hidden. 

 
Apply a fill color 
 
Shading includes fill colors and also patterns that you can 

apply to table cells. 

 

 Select the cells where you want to apply a fill 

color. The Table Tools appear on the Ribbon. 

 
 Under Table Tools on the Ribbon, click the 

Design tab and click the Shading list arrow in the 

Table Styles group. 
 

A palette of fill colors appears. 

 
 Select a fill color from the list.  

The color is applied. 
Figure 9-25: A table with a fill color applied. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 9-26: The Shading tab of the Borders and Shading  
dialog box.  
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Using Table Styles 
 
You can easily spice up your tables by applying built-

in table formatting styles. 
 

Apply a table style 
 
By default, a table is created with the Table Grid style, 

which includes a basic black border around each cell in 

the table. Word includes many built-in styles that 

include more interesting formatting. 
 

 Select the table. 

 
 Under Table Tools on the Ribbon, click the 

Design tab. 
 

Here you can see the Table Styles group. You can 

use the arrow buttons to scroll through the table 

styles in the gallery. 
 

 Select the style you want to use in the Table 

Styles group. 
 

Tip: To display the entire Table Styles gallery, 

click the More button in the Table Styles group. 
 
 

Remove a table style 
 
You can easily remove table styles. 

 

 Select the table from which you want to remove the 

style. 
 

The Design tab appears. 

 
 Under Table Tools on the Ribbon, click the 

Design tab and click the More button in the Table 

Styles group. 
 

 Select Clear. 
 

The Table Normal style, which doesn’t have 

any formatting, is applied. 
 

Create a custom table style 
 
You can also create a new, custom table style that 

meets your exact specifications. 
 

 Select the table you want to format with a style. 

 
 Under Table Tools on the Ribbon, click the 

Design tab and click the More button in the Table 

Styles group. 

 

 
 Exercise  

 Exercise File: SalesReps9-12.docx 
 

 Exercise: Apply the “Medium Shading 1 – Accent 1” 

table style. 

 
 

 
Table styles gallery  

 
 
 
 
 
 
 

More button 

 
Figure 9-27: The Table Styles group.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 9-28: The Create New Style from Formatting 

dialog box. 
 

 
 
 
 
 

 



First level / Microsoft Word 2010  Lab 9: Working with Tables 

 

Mustansiriyah University/ College of Dentistry  Lecturer: Mustafa H. Ali 

 

P
a

g
e
1

8
 

 
 

 

 Select New Table Style. 
 

The Create New Style from Formatting dialog 

box appears. 
 

 Select the formatting attributes you want to use in the 

new table style and click OK. 
 

The new style will appear in the Custom area of the 

Table Styles gallery in the Table Styles group. 
 

Tip: You can make the new table style available 

only in the current document or for new 

documents as well. Select either the Only in 

this document or the New documents based 

on this template option in the dialog box.   

Tips 
 
 You can also use styles in the Styles group on the 

Home tab to apply styles to the text inside a table. 

These can be applied in addition to a table style.


 You can also modify an existing table style. Apply 

the style you want to modify, then click the More 

button in the Table Styles group and select 

Modify Table Style. Modify the table properties 

and click OK.

 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 9-29: A table with a style applied.  
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Using Table Style Options 
 
Besides applying table styles, you can format individual 

table style elements. 
 

 Select the table. 

 
 Under Table Tools on the Ribbon, click the 

Design tab. 
 

The formatting options available in the Table 

Style Options group include: 
 

Header Row: Displays special formatting for 

the first row of the table. 
 

Total Row: Displays special formatting for 

the last row of the table. 
 

First/Last Column: Displays special formatting 

for the first or last columns in the table. 
 

Banded Rows/Columns: Displays odd and even 

rows and columns differently for easier reading. 

 
 Select the option(s) you want to use in the Table 

Style Options group. 

 

 
 Exercise  

 Exercise File: SalesReps9-13.docx 
 

 Exercise: Select the Total Row formatting option.  
 
 
 
 
 
 
 
 
 

 
Figure 9-30: The Table Style Options group. 
 
 
 
 
 
With banded rows  
 
 
 
 
 
 

 
Without banded rows  
 
 
 
 
 

 
Figure 9-31: A table with and without banded rows.  
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Converting or Deleting a Table 
 
If you don’t want table data to appear in a table any 

longer, preferring that the contents are part of the other 

text of the document, you can convert a table to text. 

You can also simply delete a table. 
 

Convert a table to text 
 

 Place your insertion point in the table. 

 
 Under Table Tools on the Ribbon, click the Layout 

tab and click the Convert to Text button in the 

Data group. 
 

The Convert Table To Text dialog box appears. 

 
 Select the character you want to use to separate 

the text contained in each cell. 
 

You can select one of the options to separate text 

or define your own separation character in the 

dialog box. 
 

 Click OK. 
 

The table disappears and the table’s contents appear 

as document text—although the text is contained 

inside a frame. The contents of each table cell are 

separated by the character you selected. 

 

Delete a table 
 

 Place your insertion point in the table. 

 
 Under Table Tools on the Ribbon, click the 

Layout tab and click the Delete button in the 

Rows & Columns group. 
 

A list appears. 

 
 Select Delete Table. 

 
The table is deleted from the document. 

 
Other Ways to Delete a Table:  
Right-click the selection and select Delete 

Table from the contextual menu. 

 

 
 Exercise  

 Exercise File: SalesReps9-14.docx 
 

 Exercise: Convert the table to text, using tabs 

as separators. 
 

Undo the action, then delete the table.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 9-32: The Convert Table To Text dialog box. 

 
 
 
 
 
 
 
 
 
 
 

 
Before  
 
 
 
 
 
 
 

 
After  
 
 
 
 
 
 
 
 

 
Figure 9-33: Before and after converting a table to text 

using tabs to separate the text. 
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Using Quick Tables 
 
Insert a formatted table quickly by inserting one 

of Word’s built-in Quick Tables. 
 

 Click the Insert tab on the Ribbon and click the 

Table button in the Tables group. 
 

A list of table options appears. 

 
 Point to Quick Tables. 

 
A gallery of built-in tables appears. 

 
As you point to each built-in table, a description of 

the table and how it might best be used is shown. 
 

 Select the table you would like to insert. 
 

The table is inserted in the document. All you have 

to do is modify the table contents to your needs. 
 

Tips 
 
 The selection of built-in tables is dependent on the 

current document theme.

 

 
 Exercise  

 Exercise File: None required. 
 

 Exercise: Open a new document and insert the Calendar 2 

Quick Table.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 9-34: The Quick Tables gallery.  
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